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(ABOUT THIS KIT

The overall goal of this kit is fun. Beyond this, the aim is to get
you comfortable using a wide range of electronic components
through small, simple and easy circuits. The focus is to get each
circuit working then giving you the tools to figure out why. If you
encounter any problems, want to ask a question, or would like to
Kknow more about any part, extra help is only an e-mail away help@oomlout.com.

" ABOUT OPEN SOURCE HARDWARE

All of the projects at SparkFun and .:oomlout:. are open source. What does this mean? It means
everything involved in making this kit, be it this guide, 3D models, or code is available for free
download. But it goes further, you're also free to reproduce and modify any of this material, then
distribute it for yourself. The catch? Quite simple, it is released under a Creative Commons (By -
Share Alike) license. This means you must credit .:oomlout:. in your design and share your
developments in a similar manner. Why? We grew up learning and playing with open source
software and the experience was good fun, we think it would be lovely if a similar experience was
possible with physical things.

More details on the Creative Commons CC (By - Share Alike) License can be found at

\_ http://ardx.org/CCLI W,

(" ABOUT .: OOMLOUT :. )

We're a plucky little design company focusing on producing
“delightfully fun open source products”

To check out what we are up to

\_ http://www.oomlout.com Yy,

ABOUT SPARKFUN

SparkFun is an energetic young company seeking to make electronics fun, accessible,
and approachable to everyone - from kids in elementary school to PhD-toting engineers.

http://www.sparkfun.com/

(" ABOUT PROBLEMS )
We strive to deliver the highest level of quality in each and every thing we produce. If you ever find an
ambiguous instruction, a missing piece, or would just like to ask a question, we'll try our best to help out.

help@oomlout.com
\ (we like hearing about problems it helps us improve future versions) j

Thanks For Choosing .:oomlout:.
and SparkFun
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.- INSTALLING THE IDE :. 02 INST

This is the program used to write code for the Arduino. It may installing
seem a little daunting at first but once you have it installed and (software and hardware)
start playing around, its secrets will reveal themselves.

Step 1: Download the software

Go to

http://arduino.cc/en/Main/Software
download the software for your operating system

Windows XP Mac 0SX
[Step 2: Unzip the Software Step 2: Open The .dmg

Unzip Open (mount)
arduino-00 X X-win.zip (X X - version #)

Recommended Path

c:\Program Files\

arduino-00X X -mac.dmg (x x- version #)

: h I . .
Step 3: S| pgn"tCUt con Step 3: Copy The Application

c:\program files\arduino-00 X X\ (X X- version #) Go to

Right Click n . "o, . . )
Arduino.exe (send to>Desktop (create shortcut)) “Arduino” (in thelsl'“:;/‘llczs section of finder)

"Arduino" Application to the
"Applications" folder

Step 4: Plug In Your Arduino

Plug your Arduino in:
Using the included USB cable, plug your Arduino
board into a free USB port.

Wait for a box to pop up f Step 4: Install Drivers \

.:Duemilanove Boards Only:.

/~ Step 5: Add new Hardware “\ Go to

Skip searching the internet b % dé‘gcet .
(click the next box when prompted to do so) _ oubie Clic nsta
Install from a specific location FTDI Drivers for Intel Macs (X X X X).pkg

(click “Install from a list or specific location (Advanced)") K (FTDI Drivers for PPC Macs (XX X X).pkg /

Choose the Location Restart
Duemilanove Board
c:\program files\arduino-00 X X \drivers\FTDI USB Drivers\
Uno Board

k c:\program files\arduino-00 X X \drivers\ /
Finished
. Step 5: Plug In Your Arduino
VISta’ Seven Plug your Arduino in:
/Step 5: Add new Hardwa re\ Using the included USB cable, plug your Arduino

board into a free USB port.
Run Device Manager Finished
Start > Run > devmgmt.msc
Choose the Arduino
Other Devices > Arduirlo Uno (Uno) : NOTE: .
Update Driver .: Encountering problems? :.

click *Update I?river" .: Would like more details? Using Linux? :.
Select Driver .. http://ardx.org/LINU :.
click "Browse My Computer for Driver Software”

c:\program files\arduino-00 X X \drivers\
k Finished /




03 PROG _ _
. .:A Small Programming Primer:.

primer

(ARDUINO PROGRAMMING IN BRIEF )

The Arduino is programmed in the C language. This is a quick little primer targeted at people

who have a little bit of programing experience and just need a briefing on the idiosyncracies of C

and the Arduino IDE. If you find the concepts a bit daunting, don't worry, you can start going

through the circuits and pick up most of it along the way. For a more in-depth intro, the
Qrduino.cc website is a great resource.

(STRUCTURE

Each Arduino program void setup(OQ{ } void Toop(O{ 1}
(often called a sketch) has All the code between the two This function is run after setup
two required functions curly brackets will be run once has finished. After it has run
(also called routines). when your Arduino program once it will be run again, and
first runs. again, until power is removed.

\_

(SYNTAX

Vs

p
One of the slightly |/ (single line comment) /* */(multi line comment)

frustrating elements of C is It is often useful to write notes If you have a lot to say you can

its formatting requirements to yourself as you go along span several lines as a

(this also makes it very about what each line of code comment. Everything between

powerful). If you remember | [ d0¢s. To do this type two these two symbols will be

. forward slashes and everything ignored in vour program.
the_ following you should be until the end of the line will be kg yourprog
\alrlght.

kignored by your program.

J/

-
7 (semicolon)

Each line of code must be

{  (curly brackets) ended with a semicolon (a
Used to define when a block miss]ng semicolon is often

of code starts and ends (used the reason for a program
L in functions as well as loops). )| refusing to compile).

\_

NARIABLES

A program is nothing more int (integer) long (long)
than instructions to move The main workhorse, stores a Used when an integer is not

numbers around in an

/
\

number in 2 bytes (16 bits). large enough. Takes 4 bytes (32
. ; . Has no decimal places and will bits) of RAM and has a range
intelligent way. Varlgbles aré store a value between -32,768 between -2,147,483,648 and
 used to do the moving. _and 32,767.  2,147,483,647.

N\ ( N\
boolean (boolean) float (float) char (character)
A simple True or False Used for floating point math Stores one character using the
variable. Useful (decimals). Takes 4 bytes (32 ASCII code (ie 'A' = 65). Uses
because it only bits) of RAM and has a range one byte (8 bits) of RAM. The
uses one bit of between -3.4028235E+38 Arduino handles strings as an

RAM. and 3.4028235E+38. array of char’s. /
J

\




.:For a full programming reference visit:.
http://ardx.org/PROG

03 PROG

programming
primer

(MATH OPERATORS

~N

Operators used for
manipulating numbers.
(they work like simple
math).

\_

(assignment) makes something equal to something else (eg. x A

=10 * 2 (x now equals 20))

(modulo) gives the remainder when one number is divided by

another (ex. 12 % 10 (gives 2))
(addition)

(subtraction)

(multiplication)

(division)

[COMPARISON OPERATORS

_
~N

Operators used for
logical comparison.

\_

== (equal to) (eg. 12 == 10 is FALSE or 12 == 12 is TRUE)
(not equal to) (eg. 12 1= 10 is TRUE or 12 I= 12 is FALSE)
(less than) (eg. 12 < 10 is FALSE or 12 < 12 is FALSE or 12 < 14 is TRUE)
(greater than) (eg. 12 > 10is TRUE or 12 > 12 is FALSE or 12 > 14 is

FALSE)

J

(CONTROL STRUCTURE

p
Programs are reliant on
controlling what runs
next, here are the basic
control elements (there

_are many more online).

~

\_

if(condition){ }
else if( condition ){ }
else { }

This will execute the code between
the curly brackets if the condition
is true, and if not it will test the
else if condition if that is also
false the eTse code will execute.

for(int i = 0; i <
#repeats; i++){ }
Used when you would like to
repeat a chunk of code a humber
of times (can count up i++ or
down i-- or use any variable)

(DIGITAL

Used to set a pin's mode, pin
is the pin number you would
like to address 0-19 (analog 0-
5 are 14-19). The mode can
\either be INPUT or OUTPUT.

( B B N\
pinMode(pin, mode);

\_

digitalwrite(pin, value);

Once a pin is set as an OUTPUT,
it can be set either HIGH (pulled
to +5 volts) or Low (pulled to
ground).

int digitalRead(pin);
Once a pin is set as an INPUT
you can use this to return
whether it is HIGH (pulled to
+5 volts) or LOW (pulled to
ground).

/ANALOG

The Arduino is a digital
machine but it has the ability
to operate in the analog
realm (through tricks).
Here's how to deal with
things that aren't digital.

( - . .
int analogwrite(pin,

\255 (100% duty cycle ~5 volts).

value);
Some of the Arduino's pins support
pulse width modulation (3, 5, 6, 9, 10,
11). This turns the pin on and off very
quickly making it act like an analog
output. The value is any humber
between 0 (0% duty cycle ~0v) and

('i nt analogRead(pin);

When the analog input pins are set
to input you can read their voltage.
A value between 0 (for 0

volts) and 1024 (for

5 volts) will be

returned.

\
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electronics
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.:A Small Electronics Primer:.

[ELECTRONICS IN BRIEF
No previous electronic experience is required to have fun with this kit. Here are a few details

about each component to make identifying, and perhaps understanding them, a bit easier. If
at any point you are worried about how a component is used or why it's not working the
@ernet offers a treasure trove of advice, or we can be contacted at help@oomlout.com

~

/ COMPONENT DETAILS

LED

(Light Emitting Diode)

Resistors

=
%

Transistor

@

Hobby Servo

What it Does:

Emits light when a small current is
passed through it. (only in one direction)
Identifying:

Looks like a mini light bulb.

J
~N

No. of Leads:
2 (one longer, this one connects to positive)
Things to watch out for:

- Will only work in one direction

- Requires a current limiting resistor
More Details:

http://ardx.org/LED

What it Does:

The electronic equivalent of a one way
valve. Allowing current to flow in one
direction but not the other.

Identifying:

Usually a cylinder with wires extending from
either end. (and an off center line indicating polarity)

No. of Leads:
2
Things to watch out for:

- Will only work in one direction (current wil
flow if end with the line is connected to ground)

More Details:
http://ardx.org/DIOD

What it Does:

Restricts the amount of current that can

flow through a circuit.

Identifying:

Cylinder with wires extending from either
end. The value is displayed using a color
coding system (for details see next page)

No. of Leads:
2
Things to watch out for:

- Easy to grab the wrong value (double
check the colors before using)
More Details:
http://ardx.org/RESI

What it Does:

Uses a small current to switch or amplify a
much larger current.

Identifying:

Comes in many different packages but you

can read the part number off the package.
(P2N2222AG in this kit and find a datasheet online)

No. of Leads:
3 (Base, Collector, Emitter)
Things to watch out for:
- Plugging in the right way round (also a

current limiting resistor is often needed on the base pin)
More Details:

http://ardx.org/TRAN

What it Does:

Takes a timed pulse and converts it into
an angular position of the output shaft.
Identifying:

A plastic box with 3 wires coming out one
side and a shaft with a plastic horn out
the top.

No. of Leads:
3
Things to watch out for:
- The plug is not polarized so make sure
it is plugged in the right way.
More Details:
http://ardx.org/SERV

What it Does:

Spins when a current is passed through it.
Identifying:

This one is easy, it looks like a motor.
Usually a cylinder with a shaft coming out
of one end.

No. of Leads:
2
Things to watch out for:
- Using a transistor or relay that is rated
for the size of motor you're using.
More Details:
http://ardx.org/MOTO /




04 ELEC
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Pushbutton

[COMPONENT DETAILS (CONT.)
Piezo Element

What it Does:

A pulse of current will cause it to click. A
stream of pulses will cause it to emit a
tone.

Identifying:

In this kit it comes in a little black barrel,
but sometimes they are just a gold disc.

electronics
primer

No. of Leads:

2

Things to watch out for:
- Difficult to misuse.

More Details:
http://ardx.org/PIEZ

IC (Integrated Circuit)

What it Does:

Packages any range of complicated
electronics inside an easy to use package.
Identifying:

The part ID is written on the outside of the
package. (this sometimes requires a lot of
light or a magnifying glass to read).

No. of Leads:

2 - 100s (in this kit there is one with 3 (TMP36) and
one with 16 (74HC595)

Things to watch out for:

- Proper orientation. (look for marks showing pin 1)
More Details:

http://ardx.org/ICIC

What it Does:

Completes a circuit when it is pressed.
Identifying:

A little square with leads out the bottom
and a button on the top.

No. of Leads:
4
Things to watch out for:
- these are almost square so can be
inserted 90 degrees off angle.
More Details:
http://ardx.org/BUTT

Potentiometer

What it Does:

Produces a variable resistance dependant
on the angular position of the shaft.
Identifying:

They can be packaged in many different
form factors, look for a dial to identify.

No. of Leads:
3
Things to watch out for:
- Accidentally buying logarithmic scale.
More Details:
http://ardx.org/POTE

Photo Resistor

What it Does:

Produces a variable resistance dependant
on the amount of incident light.
Identifying:

Usually a little disk with a clear top and a
curvy line underneath.

No. of Leads:
2
Things to watch out for:
- Remember it needs to be in a voltage
divider before it provides a useful input.
More Details:
http://ardx.org/PHOT

[RESISTOR CoLoR CODE

Examples:
green-blue-brown - 560 ohms
red-red-red - 2 200 ohms (2.2k)

brown-black-orange - 10 000 ohms (10k tolerance

O - Black
M1 - Brown
M2 - Red
3 - Orange

5 - Green 20% - none
6 - Blue 10% - silver

M8 - Grey

M7 - Purple 5% - gold
19 - White )

K 4 - Yellow

J
ﬂEAD CLIPPING \

Some components in this kit come with very long wire
leads. To make them more compatible with a breadboard
a couple of changes are required.

LEDs:

Clip the leads so the long lead is ~10mm (3/8") long and
the short one is ~7mm (9/32").

Resistors:

Bend the leads down so they are 90 degrees to the
cylinder. Then snip them so they are ~6mm

(1/4") long.

Other Components:

Other components may need clipping.

%your discretion when doing so.




.:Getting Started.:.
.:(Blinking LED):.

"WHAT WE'RE DOING:

LEDs (light emitting diodes) are used in all sorts of clever things
which is why we have included them in this kit. We will start off
with something very simple, turning one on and off, repeatedly,
producing a pleasant blinking effect. To get started, grab the parts
listed below, pin the layout sheet to your breadboard and then plug
everything in. Once the circuit is assembled you'll need to upload the program. To do this plug the
Arduino board into your USB port. Then select the proper port in Tools > Serial Port > (the
comm port of your Arduino). Next upload the program by going to File > Upload to I/O
Board (ctrl+U). Finally, bask in the glory and possibility that controlling lights offers.

If you are having trouble uploading, a full trouble shooting guide can be found here: http://ardx.org/TRBL

\_ J
Fr HE CIRCUIT: \

ss:. CIRC-01 "
i, 2 Pin Header 5mm Yellow LED
iz Breadboard Sheet {ﬂ ' P
s x1 x4 x1 f_'\ Wire

330 Ohm Resistor
Orange-Orange-Brown
x1

/ Schematic \

Arduino
pin 13

Ionger lead

LED
(light emitting diode)

resistor (3300hm)
(orange-orange-brown)

gnd

T (ground) (-) /
The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS01S
view:,
assembly video
http://ardx.org/VIDEO1




[CODE (no need to type everything in just click)

File > Examples > 1.Basic > Blink
(example from the great arduino.cc site, check it out for other ideas)

/* Blink

* Turns on an LED on for one second, then off for one second,
* repeatedly.
Created 1 June 2005 By David cCuartielles
http://arduino.cc/en/Tutorial/Blink
based on an orginal by H. Barragan for the wiring i/o board

/
int TedPin =

*

o
o
KA
A

13; // LED connected to digital pin 13

// The setup() method runs once, when the sketch starts

void setup() // initialize the digital pin as an output:
pinMode(TedPin, OUTPUT); }

// the loop() method runs over and over again,

// as long as the Arduino has power

void Toop()
digitalwrite(ledPin, HIGH);
delay(1000);

digitalwrite(ledPin, LOW);
delay(1000);

// set the LED on

// wait for a second
// set the LED off
// wait for a second

\

(NOT WORKING? (3 things to try)

\

f Program Not Uploading‘
This happens sometimes,

the most likely cause is a
confused serial port, you
can change this in
tools>serial port>

LED Not Lighting Up?
LEDs will only work in one
direction. Try taking it out and

twisting it 180 degrees.
(no need to worry, installing it

backwards does no permanent
harm).

Still No Success?
A broken circuit is no fun, send

us an e-mail and we will get
back to you as soon as we can.

help@oomlout.com

\S 2/

\

[MAKING IT BETTER

Changing the pin:

The LED is connected to pin 13 but we can use any of
the Arduino’s pins. To change it take the wire plugged
into pin 13 and move it to a pin of your choice (from 0-
13) (you can also use analog 0-5, analog 0 is 14...)

Then in the code change the line:
int TedPin = 13; -> int ledPin

newpin;
Then upload the sketch: (ctrl-u)

Change the blink time:

Unhappy with one second on one second off?

In the code change the lines:
digitalwrite(ledPin, HIGH);
delay(time on); //(seconds * 1000)
digitalwrite(ledPin, LOW);

delay(time off); //(seconds * 1000)

Control the brightness:
Along with digital (on/off) control the Arduino can control

some pins in an analog (brightness) fashion. (more details on
this in later circuits). To play around with it.

Change the LED to pin 9: (also change the wire)
ledPin = 13; -> int TedPin

9;
Replace the code inside the { }'s of Toop () with this:
analogwrite(ledPin, new number);

(new number) = any number between 0 and 255.
0 = off, 255 = on, in between = different brightness

Fading:
We will use another included example program. To open go to

File > Examples > 3.Analog > Fading

Then upload to your board and watch as the LED fades in and
then out.

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO1




.:8 LED Fun..
.:Multiple LEDs:.

CIRC-02

N\ WHAT WE'RE DOING:

We have caused one LED to blink, now it's time to up the
stakes. Lets connect eight. We'll also have an opportunity to
stretch the Arduino a bit by creating various lighting
sequences. This circuit is also a nice setup to experiment with
writing your own programs and getting a feel for how the Arduino works.

Along with controlling the LEDs we start looking into a few simple programming methods to
keep your programs small.

for () loops - used when you want to run a piece of code several times.
arrays[] - used to make managing variables easier (it's a group of variables).

\_

ﬁl‘ HE CIRCUIT:

Parts:

sty CIRC-02

# 2 Pin Header H 5mm Yellow LED

L N A -
g gt Breadboard Sheet :
g x1 x4 x8 /—\ Wire

4r 330 Ohm Resistor
- Orange-Orange-Brown
x8

/ Schematic \

pin 2 pin 3 pin 4 pin 5

LED

resistor
3300hm
—gnd

pin 6 pin 7 pin 8 pin 9

LED

resistor
3300hm

k —gnd

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS02S
view:.
assembly video
http://ardx.org/VIDEO02




[CODE (no need to type everything in just click)

//LED Pin variables

int ledpins[] = {2,3,4,5,6,7,8,9};
//An array to hold the
//pin each LED 1is connected to
//i.e. LED #0 is connected to pin 2

void setup()

for(int i = 0; i < &; i++){
//this is a Toop and will repeat eight times
pinMode(ledPins[i],0UTPUT);

//we use this to set LED pins to output
}

¥oid ToopQ // run over and over again
oneAfterAnotherNoLoop();
//this will turn on each LED one by
//one then turn each oneoff
//oneAfterAnotherLoop();
//this does the same as onAfterAnotherNoLoop
//but with much Tess typing
//oneonAtATime();
//inAndout(Q);

oneAfterAnotherNoLoop() - will Tight one then
\de]ay for delayTime then Tight the next LED it

CIRC-02

Download the Code from ( http://ardx.org/CODE02 )
(and then copy the text and paste it into an empty Arduino Sketch)

* will then turn them off

void oneAfterAnotherNoLoop(){
int delayTime = 100;
//the time (in m1111seconds) to pause
//between LEDs
digitalwrite(ledPins[0], HIGH); //Turns on LED #0
//(connected to pin 2)

deTay(delayTime); //waits delayTime milliseconds

digitalwrite(ledPins[7], HIGH); //Turns on LED #7

//(connected to pin 9)

de1ay(de1ayT1me), //waits delayTime milliseconds
//Turns Each LED Of

d1g1ta1Wr1te(1edP1ns[7], LOW) ;

//Turns off LED #7
delay(delayTime);

//waits delayTime milliseconds

(NOT WORKING? (3 things to try)

4 \ [

Some LEDs Fail to Light
It is easy to insert an LED
backwards. Check the LEDs

that aren't working and ensure
they the right way around.

Operating out of sequence
With eight wires it's easy to cross
a couple. Double check that the
first LED is plugged into pin 2 and
each pin there after.

Starting Afresh

Its easy to accidentally
misplace a wire without
noticing. Pulling everything out
and starting with a fresh slate
is often easier than trying to
track down the problem.

S

[MAKING IT BETTER

Switching to loops:

In the loop() function there are 4 lines. The last
three all start with a '//'. This means the line is
treated as a comment (not run). To switch the
program to use loops change the void loop()

code to:
//oneAfterAnotherNoLoop();
oneAfterAnotherLoop();
//0oneOnAtATime();
//inAndoutQ);
Upload the program, and notice that nothing has
changed. You can take a look at the two
functions, each does the same thing, but use

different approaches (hint: the second one uses

\a for loop).

Extra animations:
Tired of this animation? Then try the other two

sample animations. Uncomment their lines and upload
the program to your board and enjoy the new light
animations. (delete the slashes in front of row 3 and then 4)

Testing out your own animations:
Jump into the included code and start changing

things. The main point is to turn an LED on use

digitalwrite(pinNumber, HIGH); then to turn
it off use digitalwrite(pinNumber, LOW); .

Type away, regardless of what you change you won't
break anything.

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC02




.:Spin Motor Spin:.
..Transistor & Motor:.

S
'WHAT WE'RE DOING: \ P
The Arduino's pins are great for directly controlling small electric .4

CIRC-03

items like LEDs. However, when dealing with larger items (like a

toy motor or washing machine), an external transistor is required. A
transistor is incredibly useful. It switches a lot of current using a

much smaller current. A transistor has 3 pins. For a negative type (NPN)
transistor, you connect your load to collector and the emitter to ground. Then when a small current
flows from base to the emitter, a current will flow through the transistor and your motor will spin
(this happens when we set our Arduino pin HIGH). There are literally thousands of different types of
transistors, allowing every situation to be perfectly matched. We have chosen a P2N2222AG a rather
common general purpose transistor. The important factors in our case are that its maximum voltage
(40v) and its maximum current (200 milliamp) are both high enough for our toy motor (full details
can be found on its datasheet http://ardx.org/2222).

\ (The 1N4001 diode is acting as a flyback diode for details on why its there visit: http://ardx.org/4001)

ﬂl‘ HE CIRCUIT: \

Parts:

CIRC-03 Transistor

Breadboard Sheet §  2FinHeader  # P2N22224G (T052) 7N, wire
x1 : X

Diode .+ 10k Ohm Resistor

b Toy Motor I’ I (1n4001) : Brown-Black-Orange
"‘-\,“.-1.-. x1 x1 x1

/ Schematic \ The transistor will have
Arduino — P2N2222AG printed on it

pin 9 L (some variations will have
o different pin assignments!)

Transistor
Basel P2N2222AG

CoIIector Emitter

Diode

gnd-
(ground) (-)

+5 volts /

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS03S
view:.
assembly video
http://ardx.org/VIDEO3

\ .:NOTE: if your arduino is resetting you need to install the optional capacitor:. /




[CODE (no need to type everything in just click)
Download the Code from ( http://ard

int motorPin = 9; //pin the motor is connected to
void setup() //runs once

pinMode (motorPin, OUTPUT);
}

void Toop(Q) // run over and over again
motoronThenoff();
//motoronThenoffwithspeed();
//motorAcceleration();

/%
* motoronThenoff() - turns motor on then off
* (notice this code is identical to the code we
used for_
* the blinking LED)

void motoronThenoff(){
int onTime = 2500; //on time
int offTime = 1000; //off time
digitalwrite(motorPin, HIGH);

// turns the motor On
delay(onTime); // waits for onTime milliseconds
digitalwrite(motorpPin, LOW);

// turns the motor Off
delay(offTime);// waits for offTime milliseconds

\

CIRC-03

x.org/CODEO3 )

(then simply copy the text and paste it into an empty Arduino Sketch)

void motoronThenoffwithspeed(){
int onSpeed = 200;// a number between
//0 (stopped) and 255 (full speed)
int onTime = 2500;
int offspeed = 50;// a number between
//0 (stopped) and 255 (full speed)
int offTime = 1000;
analogwrite(motorpPin, onSpeed);
/ turns the motor On
deTay(onTime); // waits for onTime milliseconds
analogwrite(motorpPin, offSpeed);
// turns the motor Off
} delay(offTime);

void motorAcceleration(){
int delayTime 50; //time between each speed step
for(int 1 0; i < 256; i++){
//goes through each speed from 0 to 255
analogwrite(motorpPin, 1i); //sets the new speed
delay(delayTime);// waits for delayTime milliseconds

// waits for offTime milliseconds

for(int i = 255; i >= 0; i--){
//goes through each speed from 255 to O
analogwrite(motorPin, i); //sets the new speed
delay(delayTime);//waits for delayTime milliseconds

J

(NOT WORKING? (3 things to try)

“\\

4 \ [

Motor Not Spinning?
If you sourced your own
transistor, double check with
the data sheet that the pinout
is compatible with a
P2N2222AG
(many are reversed).

work with

Still No Luck?
If you sourced your own
motor, double check that it will

does not draw too much

Still Not Working?
Sometimes the Arduino board
will disconnect from the
computer. Try un-plugging and
then re-plugging it into your
USB port.

5 volts and that it

power.

S

2/

[MAKING IT BETTER

Controlling speed:
We played with the Arduino's ability to control the

brightness of an LED earlier now we will use the same
feature to control the speed of our motor. The Arduino
does this using something called Pulse Width
Modulation (PWM). This relies on the Arduino's ability to
operate really, really fast. Rather than directly
controlling the voltage coming from the pin the Arduino
will switch the pin on and off very quickly. In the
computer world this is going from 0 to 5 volts many
times a second, but in the human world we see it as a
voltage. For example if the Arduino is PWM'ing at 50%
we see the light dimmed 50% because our eyes are not
quick enough to see it flashing on and off. The same
feature works with transistors. Don't believe me? Try it

\out.

“\\

In the Toop () section change it to this

// motoronThenoff();
motoronThenoffwithSpeed();

// motorAcceleration();

Then upload the program. You can change the speeds by

changing the variables onSpeed and offSpeed.

Accelerating and decelerating:
Why stop at two speeds, why not accelerate and decelerate

the motor. To do this simply change the loop() code to read

// motoronThenoff();

// motoronThenoffwithspeed();
motorAcceleration();

Then upload the program and watch as your motor slowly
accelerates up to full speed then slows down again. If you
would like to change the speed of acceleration change the
variable delayTime (larger means a longer acceleration time).

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO03




.:A Single Servo:.
.:Servos:.

CIRC-04

" WHAT WE'RE DOING:

Spinning a motor is good fun but when it comes to projects
where motion control is required they tend to leave us
wanting more. The answer? Hobby servos. They are mass
produced, widely available and cost anything from a couple of
dollars to hundreds. Inside is a small gearbox (to make the movement more powerful) and
some electronics (to make it easier to control). A standard servo is positionable from 0 to

180 degrees. Positioning is controlled through a timed pulse, between 1.25 milliseconds (0
degrees) and 1.75 milliseconds (180 degrees) (1.5 milliseconds for 90 degrees). Timing
varies between manufacturer. If the pulse is sent every 25-50 milliseconds the servo will run
smoothly. One of the great features of the Arduino is it has a software library that allows
Qou to control two servos (connected to pin 9 or 10) using a single line of code. j

/ THE CIRCUIT: \

Parts:

CIRC-04

| 2 Pin Header i 3 Pin Header
Breadboard Sheet ﬁ' q‘ .
x1 x4 J x1 /—\ Wire

Mini Servo
x1

/ Schematic \

Arduino____
pin9

Mini Servo
sl

(ground) () — 5 %ol

+5 volts
\ o)
The Internet \

.:download:.
breadboard layout sheet
http://ardx.org/BBLS04S
.view:.
assembly video
http://ardx.org/VIDEO4

%




[CODE (no need to type everything in just click) c I RC — 04

File > Examples > Servo > Sweep
(example from the great arduino.cc site, check it out for other great ideas)

// Sweep
// by BARRAGAN <http://barraganstudio.com>

#include <Servo.h> .
Servo myservo; // create_servo object to control a servo
int pos = 0; // variable to store the servo position

void setup() {
myservo.attach(9); // attaches the servo on pin 9 to the servo object

void Toop() {
for(pos = 0; pos < 180; pos += 1) // goes from O degrees to 180 degrees
{ // 1n steps of 1 degree
myservo.write(pos); // tell servo to go to position in variable 'pos'
delay(15); // waits 15ms for the servo to reach the position

Eor(pos = 180; pos>=1; pos-=1) // goes from 180 degrees to O degrees

myservo.write(pos); // tell servo to go to position in variable 'pos'
delay(15); // waits 15ms for the servo to reach the position

\__ J

(NOT WORKING? (3 things to try) )

4 Y é N

Fits and Starts
Still Not Working If the servo begins moving then
A mistake we made a time or twitches, and there's a flashing
i i light Ardui th
still shockingly easy to plug a two was simply forgetting to ight on your Arduino bOaTd' . ©
servo in backwards. This might connect the power (red and power.supply you are sing 1s
be the case brown wires) to +5 volts and not quite up to the challenge.
' ground. Using a fresh battery instead of
USB should solve this problem.

\S 2/

[MAKING IT BETTER R

Potentiometer control: void ToopO {

We have yet to experiment with inputs but if you would like int pulseTime = 2100; //(the number of microseconds

to read ahead, there is an example program File > Servo > %tgogagsgeg?‘gegl;(1)809({83‘33;8?265)

Knob. This uses a potentiometer (CIRCO8) to control the digitalwrite(servoPin, HIGH);
delayMicroseconds (pulseTime);
servo. You can find instructions online here: 31%11 te(\;vsv§1 te(servoPin, LOW);
elay H
http://ardx.org/KNOB }

Servo Not Twisting?
Even with colored wires it is

Self timing: Great ideas:
While it is easy to control a servo using the Arduino's included ~ Servos can be used to do all sorts of great things, here are a few of

library sometimes it is fun to figure out how to program our favorites.
something yourself. Try it. We're controlling the pulse directly .

. Xmas Hit Counter
so you could use this method to control servos on any of the http://ardx.org/XMAS
Arduino's 20 available pins (you need to highly optimize this

code before doing that). Open Source Robotic Arm (uses a servo controller as well as the Arduino)
http://ardx.org/RARM

int servoPin = 9;

void setupOQ{ | . Servo Walker
\} pinMode(servoPin,OUTPUT) ; http://ardx.org/SEWA

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC04




CIRC-05 .:8 More LEDs:.
.:74HC595 Shift Register:.

'\ WHAT WE'RE DOING:

Time to start playing with chips, or integrated circuits (ICs) as they like to
be called. The external packaging of a chip can be very deceptive. For
example, the chip on the Arduino board (a microcontroller) and the one we
will use in this circuit (a shift register) look very similar but are in fact rather
different. The price of the ATMega chip on the Arduino board is a few dollars
while the 74HC595 is a couple dozen cents. It's a good introductory chip, and once you're comfortable playing
around with it and its datasheet (available online http://ardx.org/74HC595 ) the world of chips will be your oyster.
The shift register (also called a serial to parallel converter), will give you an additional 8 outputs (to control LEDs
and the like) using only three Arduino pins. They can also be linked together to give you a nearly unlimited
number of outputs using the same four pins. To use it you “clock in” the data and then lock it in (latch it). To do
this you set the data pin to either HIGH or LOW, pulse the clock, then set the data pin again and pulse the clock
repeating until you have shifted out 8 bits of data. Then you pulse the latch and the 8 bits are transferred to the
shift registers pins. It sounds complicated but is really simple once you get the hang of it.

(for a more in depth look at how a shift register works visit: http://ardx.org/SHIF)

J
ﬂl’ HE CIRCUIT: \

Parts:

CIRC-05

2 . - Shift Register
#"%" Breadboard Sheet ¥ )2(4P|n Header “ 74HC595 f—\ Wire

x1 x1

* =5 330 Ohm Resistor

Red LED Orange-Orange-Brown
x8 x8

/ Schematic \

+5 volts

pin pin pin
4 3 2
74H|C595

resistor
(3300hm)

LED

+5V

(ground) (-)

data
clock
latch

\ gnd

The Internet

_I_ gnd

There is a half moon
& cutout, this goes at the top

i

|

.:download:.
breadboard layout sheet
http://ardx.org/BBLS05S
view:.
assembly video
http://ardx.org/VIDEO5




(CODE (no need to type everything in just click)

Download the Code from ( http://ardx.org/CODEOQS5 )
(copy the text and paste it into an empty Arduino Sketch)

CIRC-05

//Pin Definitions

//The 74HC595 uses a serial communication
//1ink which has three pins

int data = 2;

int clock 3;
int Tatch 4;

digitalwrite(latch, LOwW);

//Pulls the chips latch Tow
shiftout(data, clock, MSBFIRST, value);

void setup() //runs once

pinMode(data, OUTPUT);
pinMode(cTlock, OUTPUT);
pinMode(latch, OuTPUT); 1}

// run over and over again

int delayTime = 100;

//delay between LED updates
for(int i = 0; 1 < 256; i++){
updateLEDs (i) ;
delay(delayTime); }

void Tloop()

* updateLEDs() - sends the LED states set
* in value to the 74HC595 sequence

“/
\xgid updateLEDs(int value){

//Shifts out 8 bits to the shift register

digitalwrite(latch, HIGH);

//Pulls the latch high displaying the data

(NOT WORKING? (3 things to try)

\

The Arduino’s power

LED goes out
This happened to us a couple
of times, it happens when the
chip is inserted backwards. If
you fix it quickly nothing will
break.

Not Quite Working
Sorry to sound like a broken
record but it is probably
something as simple as a
crossed wire.

~
Frustration?
Shoot us an e-mail, this circuit
is both simple and complex at
the same time. We want to
hear about problems you have
so we can address them in
future editions.
help@oomlout.com

\J

2/

(MAKING IT BETTER

Doing it the hard way:
An Arduino makes rather complex actions very easy, shifting out data is

one of these cases. However one of the nice features of an Arduino is
you can make things as easy or difficult as you like. Let's try an

example of this. In your loop switch the line:
updateLEDs (i) -> updateLEDsLong(i);
Upload the program and notice nothing has changed. If you look at the

code you can see how we are communicating with the chip one bit at a
time. (for more details http://ardx.org/SPI ).

Controlling individual LEDs:

Time to start controlling the LEDs in a similar method as we did in
CIRCO2. As the eight LED states are stored in one byte (an 8 bit value)
for details on how this works try http://ardx.org/BINA. An Arduino is
very good at manipulating bits and there are an entire set of operators
that help us out. Details on bitwise maths ( http://ardx.org/BITW ).

Our implementation.
Replace the Toop () code with
int delayTime = 100; //the number of milliseconds
//to delay

\

//between LED updates
for(int i = 0; i < 8; i++){
changeLED(i,0N);
delay(delayTime);

for(int i = 0; i < 8; i++){
changeLED(i,0FF);
delay(delayTime);
Uploading this will cause the lights to light up one after another and then off
in a similar manner. Check the code and wikipedia to see how it works, or
shoot us an e-mail if you have questions.

More animations:
Now things get more interesting. If you look back to the code from CIRCO02 (8

LED Fun) you see we change the LEDs using digitalWrite(led, state), this is
the same format as the routine we wrote changeLED(led, state). You can use
the animations you wrote for CIRC02 by copying the code into this sketch and
changing all the digitalWrite()'s to changeLED()'s. Powerful? Very. (you'll also
need to change a few other things but follow the compile errors and it works
itself out).

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC05




.:Music:.
.:Piezo Elements.:.

CIRC-06

"WHAT WE'RE DOING:

To this point we have controlled light, motion, and
electrons. Let's tackle sound next. But sound is an
analog phenomena, how will our digital Arduino cope?

We will once again rely on its incredible speed which will let it

mimic analog behavior. To do this, we will attach a piezo element to one of the
Arduino's digital pins. A piezo element makes a clicking sound each time it is pulsed
with current. If we pulse it at the right frequency (for example 440 times a second to
make the note middle A) these clicks will run together to produce notes. Let's get to
experimenting with it and get your Arduino playing "Twinkle Twinkle Little Star".

J
Fr HE CIRCUIT: \

Parts:

CIRC-06 § 2 Pin Header

Piezo Element .
:;eadboard Sheet ® <4 . x1 /—\\ Wire

/ Schematic \

Arduino
pin 9

Piezo
Element

gnd
(ground) (-)

J

The Internet \

.:download:.
breadboard layout sheet
http://ardx.org/BBLS06S
view:.
assembly video
http://ardx.org/VIDEO6




(CODE (no need to type everything in just click)

Download the Code from ( http://ardx

(copy the text and paste it into an empty Arduino Sketch)

/’ Melody
¥ (c1eft) 2005 D. cuartielles for K3
* This example uses a piezo speaker to play melodies. It sends
* a square wave of the appropriate frequency to the piezo,
* generating the corresponding tone.

* The calculation of the tones is made following the
* mathematical operation:

timeHigh = period / 2 1/ (2 * toneFrequency)

* where the different tones are described as in the table:

frequency period timeHigh
261 Hz 38
Hz
Hz
Hz
Hz
Hz
Hz
Hz

f/http://www.arduino.cc/en/Tutoria]/Me]ody

int speakerpin = 9;

int length = 15; // the number of notes
char notes[] = "ccggaagffeeddc "; // a space represents a rest
int beats(] ={1, 1, 1, 1, 1,1, 2,1, 1, 1, 1, 1, 4
int tempo = 300;

vo1d p1ayT0ne(1nt tone, int duration) {
for (10n? i =0; i < duration * 1000L; i += tone *
w

K digitalwrite(speakerpPin, HIGH);

2) {

CIRC-06

.org/CODEO06 )

digitalwrite(speakerprin,

ow) ;

Low);
delaymicroseconds(tone);

}
void p1ayNote(char note

char names[] = { '
int tones[] = { 1915

1nt durat10n) {

1700 1519 1432

1275

Tt

oy
1136 1014, 956
// play the tone corresponding to the note name
for (int i ;1< 8, i++)
if (names[i] == note) {
playTone(tones[i], duration);

}
}

void setup() {

pinMode(speakerPin, OUTPUT);

void Toop() {
for (int i =0; i < 1en th;
if (notes[i] == "'
de1ay(beats[1] * tempo); // rest
} else {
playNote(notes[i], beats[i] *

i++) {

tempo) ;

// pause between notes
delay(tempo / 2);

deTayMicroseconds(tone);
(NOT WORKING? 3 things to try)

q N\

No Sound
Given the size and shape of
the piezo element it is easy to
miss the right holes on the
breadboard. Try double
checking its placement.

whilst you thi
program then

Can't Think While the

Melody is Playing?
Just pull up the piezo element

Tired of Twinkle Twinkle

Little Star?
The code is written so you can

easily add your own songs,
check out the code below to
get started.

nk, upload your
plug it back in.

\J

G’lAKING IT BETTER

Playing with the speed:

The timing for each note is calculated based on
variables, as such we can tweak the sound of each note
or the timing. To change the speed of the melody you
need to change only one line.

int tempo ; ---> int tempo (new #)
Change it to a larger number to slow the melody down,

or a smaller number to speed it up.
Tuning the notes:
If you are worried about the notes being a little out of

tune this can be fixed as well. The notes have been
calculated based on a formula in the comment block at
the top of the program. But to tune individual notes just
adjust their values in the tones[] array up or down
until they sound right. (each note is matched by its
name in the names[] (array ie. c = 1915)

\_

9,
1700, 1519, 1432,

’

={ e,

= { 1915,

char names[] 'd', 'e ', a 'b',

int ténes[]
1014, 956 };

Composing your own melodies:

The program is pre-set to play "Twinkle Twinkle Little Star'
however the way it is programmed makes changing the song
easy. Each song is defined in one int and two arrays, the int
Tength defines the number of notes, the first array
notes[] defines each note, and the second beats[]

defines how long each note is played. Some Examples:
Twinkle Twinkle L|ttIe Star
int Tength
char notes[] = { 'ccggaagffeeddc "};
int beats[] = { 1, 2,

1275, 1136,

1, 1, 1, 1,

1, 1,
Happy Birthday (first line)
int Tength 3;

char notes[] =
int beats[]

4}

{"ccdcfeccdcgf "3;
- {1,1,1,1,1,2,1,1,1.1,1,2,4};

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.

org/CIRC06




.:Button Pressing:.
.:Pushbuttons:.

'\ WHAT WE'RE DOING:

Up to this point we have focused entirely on outputs, time to

get our Arduino to listen, watch and feel. We'll start with a

simple pushbutton. Wiring up the pushbutton is simple. There is
one component, the pull up resistor, that might seem out of place.
This is included because an Arduino doesn't sense the same way we do (ie button pressed,
button unpressed). Instead it looks at the voltage on the pin and decides whether it is HIGH
or LOW. The button is set up to pull the Arduino's pin LOW when it is pressed, however, when
the button is unpressed the voltage of the pin will float (causing occasional errors). To get the
Arduino to reliably read the pin as HIGH when the button is unpressed, we add the pull up
resistor.

\ (note: the first example program uses only one of the two buttons)

J
/ THE CIRCUIT: \

Parts:

CIRC-07 .

e | 2 Pin Header -’-. Pushbutton
Breadboard Sheet ﬁl gt i
xi x4 ox2 f—\\ Wire

Red LED
x1

Brown-Black-Orange Orange-Orange-Browi

10k Ohm Resistor o 330 Ohm Resistor *
x2 x1

/ Schematic \

Arduino
pin 2 pin 3
Arduino T+5volts |
pin 13

AAA AAA
YVV-VVWY

resistor

(pull-up)
LED (10k ohm)

] o

resistor pushbutton
(330 ohm)

S

D

! ?grr]o?lnd) (=) /

/" The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS07S
view:.
assembly video
http://ardx.org/VIDEO?7

.
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[CODE (no need to type everything in just click)

File > Examples > 2.Digital > Button
(example from the great arduino.cc site, check it out for other great ideas)

CIRC-07

* Button
* by DojoDave <http://www.0j0.org>

* Turns on and off a light emitting diode(LED) connected to digital
* pin 13, when pressing a pushbutton attached to pin 7.
* http: //www arduino.cc/en/Tutorial/Button

int ledPin = 13;
int inputPin = 2;
int val = 0;
void setup() {

pinMode(ledPin,
pinMode(inputPin,

// choose the pin for the LED
// choose the input pin (for a pushbutton)
/ variable for reading the pin status

declare LED as output

/
OUTPUT) ; //
// declare pushbutton as input

INPUT);

void Toop(){
val = digitalRead(inputPin); // read input value
if (val == HIGH) { // check if the input is HIGH
) dqgit?mriteﬂedm’n, Low); // turn LED OFF
else

digitalwrite(ledPin, HIGH); // turn LED ON

\_ Y,

(NOT WORKING? (3 things to try) )

4 Y é N

Light Not Turning On Light Not Fading
The pushbutton is square A bit of a silly mistake we
and because of this it is easy constantly made, when you
to put it in the wrong way. switch from simple on off to
Give it a 90 degree twist and fading remember to move the
see if it starts working. LED wire from pin 13 to pin 9.

Underwhelmed?
No worries these circuits are all

super stripped down to make

playing with the components
easy, but once you throw them

together the sky is the limit.

2/
“\\

N

[MAKING IT BETTER

On button off button:

Fading up and down:

The initial example may be a little underwhelming (ie. I
don't really need an Arduino to do this), let's make it a
little more complicated. One button will turn the LED on
the other will turn the LED off. Change the code to:

int ledPin = 13;
int inputPinl = 3;
int inputPin2 = 2;

// choose the pin for the LED
// button 1
// button 2

void setup() {
pinMode(ledPin, OUTPUT); // declare LED as output
pinMode(inputPinl, INPUT); // make button 1 an input
pinMode(inputPin2, INPUT), // make button 2 an input

vo1d Toop({
f (digitalRead(inputPinl) == Low) {
digitalwrite(ledPin, LOW); // turn LED OFF
} else if (d1g1ta1Read(1nputPin2) == Low) {
digitalwrite(ledPin, HIGH); // turn LED ON

}
Upload the program to your board, and start toggling the

\LED on and off.

Lets use the buttons to control an analog signal. To do this
you will need to change the wire connecting the LED from pin
13 to pin 9, also change this in code.

int ledPin = 13; ----> int ledPin = 9;
Next change the loop() code to read.

int value = 0;

void Toop(){
if (digitalRead(inputPinl) == Low) { value--; }
else if (d1g1ta1Read(1nputP1n2) == Low) { va1ue++ }
value = constrain(value, 0, 255);
analogwrite(ledPin, value);
delay(10);

Changing fade speed:
If you would like the LED to fade faster or slower, there is only

one line of code that needs changing;
delay(10); ----> delay(new #);

To fade faster make the number smaller, slower requires a
larger number.

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC07




.:Twisting:.

CIRC-03 )
..Potentiometers:.

"WHAT WE'RE DOING:

Along with the digital pins, the Arduino also has 6
pins which can be used for analog input. These
inputs take a voltage (from 0 to 5 volts) and convert
it to a digital number between 0 (0 volts) and 1024 (5 volts) (10 bits of
resolution). A very useful device that exploits these inputs is a potentiometer
(also called a variable resistor). When it is connected with 5 volts across its
outer pins the middle pin will read some value between 0 and 5 volts
dependent on the angle to which it is turned (ie. 2.5 volts in the middle). We
\can then use the returned values as a variable in our program.

J
Fr HE CIRCUIT: \
ﬂ’arts:

CIRC-08 ) . Potentiometer
* Breadboard Sheet ﬁl 2 Pin Header ‘ 10k ohm

x1 x4 x1

330 Ohm Resistor
Orange-Orange-Brown
x1 x1

/ Schematic \

Arduino +5 \f?lts

pin 13

Yellow LED 7

Arduino

. analog
Potentiometer pin 0

LED

N (light I
emittin %b
diode)

resistor (3300hm)
(orange-orange-brown)

—
—— gnd
\— (ground) (-)

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS08S
view:.
assembly video
http://ardx.org/VIDEOS




(c

ODE (no need to type everything in just click)

/* Analog Input

digital pin 13.
* The
* analogRead().

* Created by David Cuartielles

* Modified 16 Jun 2009

* By Tom Igoe
*/http://arduino.cc/en/Tutoria1/Ana1ogInput

int sensorPin = 0;
int ledPin =_13;
int sensorvalue = 0;

void setup() {
pinMode(ledPin, OUTPUT);

void Toop() {
sensorvValue = analogRead(sensorpPin)
diglgitamrite(]edpin, HIGH);
delay(sensorvalue);
digitalwrite(ledpPin, LOW);
delay(sensorvalue);

i//
//
//
//
//

* Demonstrates analog input by reading an analog sensor on analog
* pin 0 and turning on and off a Tight emitting diode(LED)

CIRC-0

File > Examples > 3.Analog > AnalogInput
(example from the great arduino.cc site, check it out for other great ideas)

8

connected to

amount of time the LED will be on and off depends on the value obtained by

// select the input pin for the potentiometer
// select_the pin for the LED )
// variable to store the value coming from the sensor

//declare the ledPin as an OUTPUT:

value from the sensor:

TedPin on

program for <sensorvalue> milliseconds:
ledPin off:

program for for <sensorvalue> milliseconds:

(NOT WORKING? (3 things to try)

( ) (
Sporadically Working
This is most likely due to a
slightly dodgy connection with
the potentiometer's pins. This
can usually be conquered by
taping the potentiometer down.

Not Working
Make sure you haven't
accidentally connected the
potentiometer's wiper to digital
pin 2 rather than analog pin 2.
(the row of pins beneath the
power pins)

Still Backward
You can try operating the
circuit upside down.
Sometimes this helps.

S

[MAKING IT BETTER

Threshold switching:
Sometimes you will want to switch an output when a value
exceeds a certain threshold. To do this with a
potentiometer change the Toop () code to.
void Toop() {

int threshold = 512;

if(analogrRead(sensorPin) > threshold){
digitalwrite(ledPin, HIGH);}

else{ digitalwrite(ledPin, LOW);}
This will cause the LED to turn on when the value is above
512 (about halfway), you can adjust the sensitivity by
changing the threshold value.
Fading:
Let’s control the brightness of an LED directly from the
potentiometer. To do this we need to first change the pin
the LED is connected to. Move the wire from pin 13 to pin

9 and change one line in the code.
\ int ledPin = 13; ----> int ledPin = 9;

Then change the loop code to.
void Toop() {

int value = analogRead(potPin) / 4;

analogwrite(ledPin, value);
Upload the code and watch as your LED fades in relation to
your potentiometer spinning. (Note: the reason we divide the
value by 4 is the analogRead() function returns a value from 0
to 1024 (10 bits), and analogWrite() takes a value from 0 to
255 (8 bits) )
Controlling a servo:
This is a really neat example and brings a couple of circuits
together. Wire up the servo like you did in CIRC-04, then open
the example program Knob (File > Examples > Servo >

Knob ), then change one line of code.

int potpin = 0; ----> int potpin = 2;
Upload to your Arduino and then watch as the servo shaft turns
as you turn the potentiometer.

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC08




.:Light:.
..Photo Resistors:.

CIRC-09

'\ WHAT WE'RE DOING:

Whilst getting input from a potentiometer can be useful

for human controlled experiments, what do we use

when we want an environmentally controlled

experiment? We use exactly the same principles but instead
of a potentiometer (twist based resistance) we use a photo resistor (light based
resistance). The Arduino cannot directly sense resistance (it senses voltage) so we
set up a voltage divider (http://ardx.org/VODI). The exact voltage at the sensing
pin is calculable, but for our purposes (just sensing relative light) we can
experiment with the values and see what works for us. A low value will occur when
\the sensor is well lit while a high value will occur when it is in darkness.

J
ﬂl‘ HE CIRCUIT: \

Parts:
CIRC-09

F 2 Pin Header ko Photo-Resistor

Breadboard Sheet Wi
B x4 imoxa ¢, Wire

10k Ohm Resistor s 330 Ohm Resistor Yellow LED
Brown-Black-Orange Orange-Orange-Brov | | : ow
x1 x1 x

/ Schematic \

Arduino

+5 volts

< photo
‘C resistor
Arduino|
analog
pin 0
resistor resistor
(3300hm) < (10k ohm)

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS09S
view:.
assembly video
http://ardx.org/VIDEQ9




(c

ODE (no need to type everything in just click)

(copy the text and paste it into an empty Arduino Sketch)
/%

* A simple programme that will change the

* dintensity of an LED based on the amount of

* Tight incident on the photo resistor.
*/

//PhotoResistor Pin
int 1ightPin = 0; //the analog pin the
//photoresistor s
//connected to
//the photoresistor is not
//calibrated to any units so
//this is simply a raw sensor
//value (relative light)
//LED Pin
int ledPin = 9;//the pin the LED is connected to
//we are controlling brightness so
//we use one of the PwM (pulse
//width modulation pins)

void setup()

pinMode(TedPin, OUTPUT); //sets the led pin to

CIRC-09

Download the Code from ( http://ardx.org/CODEOQ9 )

//output
}

/%

* Toop() - this function will start after setup
* finishes and then repeat

:\/
void Toop()
{

int lightLevel = analogRead(lightPin); //Read the
// Tightlevel
TightLevel = map(lightLevel, 0, 900, 0, 255);
//adjust the value 0 to 900 to O to 255
TightLevel = constrain(lightLevel, 0, 255);
//make sure the value is betwween 0 and 255
analogwrite(ledpPin, TightLevel); //write the value

}

J

(NOT WORKING? (3 things to try)

“\\

( ) (
LED Remains Dark
This is a mistake we continue
to make time and time again,
if only they could make an LED
that worked both ways. Pull it
up and give it a twist.

It Isn't Responding to
Changes in Light.

Given that the spacing of the
wires on the photo-resistor is
not standard, it is easy to
misplace it. Double check its in
the right place.

N N

Still not quite working?

You may be in a room which is
either too bright or dark. Try
turning the lights on or off to

see if this helps. Or if you have
a flashlight near by give that a

try.

S

2/

[MAKING IT BETTER

Reverse the response:

Perhaps you would like the opposite response. Don't

worry we can easily reverse this response just change:
analogwrite(ledPin, lightLevel); ---->
analogwrite(ledpPin, 255 - TlightLevel);

Upload and watch the response change:

Night light:
Rather than controlling the brightness of the LED in
response to light, let's instead turn it on or off based on

a threshold value. Change the loop() code with.
void Toop(){
int threshold = 300;
if(analogread(1ightPin) > threshold){
digitalwrite(ledPin, HIGH);
}else{
digitalwrite(ledPin, LOW);

}

-

“\\

Light controlled servo:
Let's use our newly found light sensing skills to control a

servo (and at the same time engage in a little bit of Arduino
code hacking). Wire up a servo connected to pin 9 (like in
CIRC-04). Then open the Knob example program (the same
one we used in CIRC-08) File > Examples > Servo >
Knob. Upload the code to your board and watch as it works

unmodified.
Using the full range of your servo:
You'll notice that the servo will only operate over a limited

portion of its range. This is because with the voltage dividing
circuit we use the voltage on analog pin 0 will not range from
0 to 5 volts but instead between two lesser values (these
values will change based on your setup). To fix this play with
the val = map(val, 0, 1023, 0, 179); line. For hints on what to
do visit http://arduino.cc/en/Reference/Map .

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC09




CIRC-10 ..Temperature:.

.:TMP36 Precision Temperature Sensor:.

/ WHAT WE'RE DOING:

What's the next phenomena we will measure with our
Arduino? Temperature. To do this we'll use a rather
complicated IC (integrated circuit) hidden in a package
identical to our P2N2222AG transistors. It has three pin's,

ground, signal and +5 volts, and is easy to use. It outputs 10
millivolts per degree centigrade on the signal pin (to allow measuring temperatures below
freezing there is a 500 mV offset eg. 25° C = 750 mv, 0° C = 500mV). To convert this from the
digital value to degrees, we will use some of the Arduino's math abilities. Then to display it
we'll use one of the IDE's rather powerful features, the debug window. We'll output the value
over a serial connection to display on the screen. Let's get to it.

One extra note, this circuit uses the Arduino IDE's serial monitor. To open this, first upload the
program then click the button which looks like a square with an antennae.

The TMP36 Datasheet:
Qttp://ardx.org/TMP36

ﬁ HE CIRCUIT:
/ Parts:

CIRC-10
Breadboard Sheet
x1

TMP36

Temperature Sensor Wire
x1 {‘_‘\
/ Schematic \

Arduino
analog 9+5 volts

pin 0

75 TMP36 i : e : o

signal ) _ (precision ety ; ; : N the chip will have

gng/ temperature 2 s i TMP36 printed
sensor) - = =

F‘ 2 Pin Header
x4

on it

—1__ gnd

\ — (ground)y
/ The Internet\

.:download:.
breadboard layout sheet
http://ardx.org/BBLS10S
view:,
assembly video
http://ardx.org/VIDE10

N /




(c

ODE (no need to type everything in just click)

(copy the text and paste it into an empty Arduino Sketch)
/i

Arduino Experimentation Kit Example Code
CIRC-10 .: Temperature :.

A simple program to output the current temperature
to the IDE's debug window
For more details on this circuit:

//TMP36 Pin variables
int temperaturepPin = 0;//the analog pin the TMP36's
//vout pin is connected to
//the resolution is
//10 mv / degree centigrade
//(500 mv offset) to make
//negative temperatures an
option
void setup()
Sserial.begin(9600); //start the serial connection
//with the computer
//to view the result open the
//serial monitor
//1ast button beneath the file
//bar (looks 1like a box with an
//antenna)

}

-

CIRC-10

Download the Code from ( http://ardx.org/CODE10 )

void Toop(Q)
// run over and over again

float temperature = getvoltage(temperaturepPin);
//getting the voltage reading from the
//temperature sensor

temperature = (temperature -
mv

.5) * 100;//converting from 10
//per degree wit 500 mv offset to
//degrees ((volatge - 500mv) times

100)

Serial.printin(temperature); //printing the result

delay(1000); //waiting a second

}

* getvoltage() - returns the voltage on the analog input
* defined by pin
*
float getvoltage(int pin){
return (analogRead(pin) * .004882814);//converting from a 0
//to 1024 digital range
// to 0 to 5 volts
//(each 1 reading equals ~ 5
millivolts

(NOT WORKING? (3 things to try)

4 )

Nothing Seems to Happen
This program has no outward

indication it is working. To see
the results you must open the

Arduino IDE's serial monitor.
(instructions on previous page)

[ Gibberish is Displayed |
This happens because the serial
monitor is receiving data at a
different speed than expected.
To fix this, click the pull-down
box that reads "*** baud" and
change it to "9600 baud".

Temperature Value is
Unchanging
Try pinching the sensor with
your fingers to heat it up or
pressing a bag of ice against it
to cool it down.

S

2/

[MAKING IT BETTER

Outputting voltage:
This is a simple matter of changing one line. Our

sensor outputs 10mv per degree centigrade so to get
voltage we simply display the result of getVoltage().

delete the line  temperature = (temperature - .5) * 100;

Outputting degrees Fahrenheit:
Again this is a simple change requiring only math. To

go degrees C ----> degrees F we use the formula:
(F=C*18)+ 32)
add the line
tempe rature
(((temperature - .5) * 100)*1.8) + 32;
before Serial.printin(temperature);

More informative output:
Let's add a message to the serial output to make what

us appearing in the Serial Monitor more informative. To

“\\

do this first revert to the original code then change:
Serial.printin(temperature);
—_————>
Serial.print(temperature);
Serial.printin(" degrees centigrade™);

The change to the first line means when we next output it
will appear on the same line, then we add the informative

text and a new line.
Changing the serial speed:
If you ever wish to output a lot of data over the serial line

time is of the essence. We are currently transmitting at 9600
baud but much faster speeds are possible. To change this

change the line:
Serial.begin(9600); ----> Serial.begin(115200);

Upload the sketch turn on the serial monitor, then change
the speed from 9600 baud to 115200 baud in the pull down
menu. You are now transmitting data 12 times faster.

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC10




.:Larger Loads:.
.:Relays:.

"\ WHAT WE'RE DOING:

This next circuit is a bit of a test. We combine what we learned
about using transistors in CIRCO3 to control a relay. A relay is
an electrically controlled mechanical switch. Inside the little
plastic box is an electromagnet that, when energized, causes a

switch to trip (often with a very satisfying clicking sound). You can buy relays that vary in size
from a quarter of the size of the one in this kit up to as big as a fridge, each capable of
switching a certain amount of current. They are immensely fun because there is an element of
the physical to them. While all the silicon we've played with to this point is fun sometimes, you
may just want to wire up a hundred switches to control something magnificent. Relays give you
the ability to dream it up then control it with your Arduino. Now to using today's technology to

\control the past. (The 1N4001 diode is acting as a flyback diode, for details on why it's there visit: http://ardx.org/4001) j

ﬂl‘ HE CIRCUIT:

\

/ Parts:

CIRC-11 4% Diode g Transistor
“ Breadboard Sheet | (1N4001) I P2N2222AG (T092)
x1 x1 box1

10k Ohm Resistor o 330 Ohm Resistor
Brown-Black-Orange & Orange-Orange-Brown

|| Yellow LED
x1 x2 |

x1

Relay
‘ (SPDT)
x1

Red LED
x1

)2(4Pin Headey
/ Schematic \

Arduino
pin 2

resistor
(10kohm)

Transistor
Base| P2N2222AG

(ground) (- —

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS11S
view:.
assembly video
http://ardx.org/VIDE11

the transistor will have
P2N2222AG printed on it

(some variations will have
the pin assignment reversed)




* Blink

* The basic Arduino example.

int TedPin = 2;
void setup()
pinMode(TedPin, OUTPUT);

\{/01’ d ToopQ)

digitalwrite(ledPin, HIGH);
delay(1000);
digitalwrite(ledPin, LOW);
delay(1000);

\_

* then off for one second, and so on...
* depending on your Arduino board, it has either a built-in LED
* or a built-in resistor so that you need only an LED.

// Fedddhh Rk hhn

[CODE (no need to type everything in just click)

File > Examples > 1.Basic > Blink
(example from the great arduino.cc site, check it out for other great ideas)

~f‘/http://www. arduino.cc/en/Tutorial/Blink

//
//

run once,

/7

// sets the LED on
// waits for a second
// sets the LED off
// waits for a second

run over and over again

Turns on an LED on for one second,
we use pin 13 because,

CHANGE TO PIN 2 Fedededededededefeddd
when the sketch starts

sets the digital pin as output

J

(NOT WORKING? (3 things to try)

\

4 )

Nothing Happens

The example code uses pin 13
and we have the relay
connected to pin 2. Make sure
you made this change in the
code.

e

No Clicking Sound
The transistor or coil portion of
the circuit isn't quite working.
Check the transistor is plugged
in the right way.

Not Quite Working
The included relays are
designed to be soldered rather
than used in a breadboard. As
such you may need to press it
in to ensure it works (and it
may pop out occasionally).

S

2/

[MAKING IT BETTER

Watch the Back-EMF Pulse

Controlling a Motor

-

Replace the diode with an LED. You'll see it blink each time it “snubs” the coil voltage spike when it turns off.

In CIRC-03 we controlled a motor using a transistor. However if you want to control a larger motor a relay is a good option.
To do this simply remove the red LED, and connect the motor in its place (remember to bypass the 330 Ohm resistor).

\

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC11




.:Colorful Light:.
.:RGB LEDs:.

CIRC-12

('WHAT WE'RE DOING:

When you first started with CIRCO1 you were happy just to
get a red LED blinking away. But you're past that now,

right? You want orange, you want teal, you want aubergine!
Fortunately there's a way to shine multiple colors from a single
LED without having to stock up on every shade of the rainbow. To do this we use a RGB
LED. An RGB LED isn't a single LED it's actually three LEDs in one small package: one
Red, one Green and one Blue. When you turn them on their light mixes together and you
get other colors. The color you get is a result of the intensity of the individual red, green
and blue LEDs. We control the intensity with Pulse Width Modulation (PWM) which we've
used before to control LED brightness and motor speed.

\_ /
ﬁ HE CIRCUIT: \

;5. CIRC-12 :
;, “ Breadboard Sheet ¥
x1

330 Ohm Resistor
Orange-Orange-Brown
x3

2 Pin Header H 5mm RGB LED

x4 x1 /‘_‘-\ Wire

Schematic

Arduino
pin 11 pin 10 pin9

resistor:
(3300hm)

(pub)uowwod

J—

=X -
o®
=%
LR, =

longest flat_7|
lead ~x side

\ —e gnd

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS12




[CODE (no need to type everything in just click)

(copy the text and paste it into an empty Arduino Sketch)

/*Cycles through the colors of a RGB LED*/

// LED leads connected to PwWM pins
const int RED_LED_PIN = 9;

const int GREEN_LED_PIN = 10;
const int BLUE_LED_PIN = 11;

// Used to store the current intensity Tevel
int redIntensity = 0;

int greenIntensity = 0;

int blueIntensity = 0;

// Length of time showing each color
const int DISPLAY_TIME = 100; // milliseconds

void setup( {
// No setup required.

CIRC-12

Download the Code from (http://ardx.org/CODE12S)

// Cycle color from green through to blue

for (blueIntensity = 0;
blueIntensity <= 255;
blueIntensity+=5) {
greenIntensity = 255-blueIntensity;
analogwrite(BLUE_LED_PIN, blueIntensity);
analogwrite(GREEN_LED_PIN, greenIntensity);
delay (DISPLAY_TIME);

// cycle cycle from blue through to red
for (rediIntensity = 0;
redIntensity <= 255;
redIntensity+=5) {
blueIntensity = 255-redIntensity;

analogwrite(RED_LED_PIN, redIntensity);
. analogwrite(BLUE_LED_PIN, blueIntensity);
void Toop()_{ delay(DISPLAY_TIME);
// Cycle color from red through to green
for (greenIntensity = 0;
greenIntensity <= 255;
greenIntensity+=5) {

redIntensity = 255-greenIntensity;
analogwrite(GREEN_LED_PIN, greenIntensity);
analogwrite(RED_LED_PIN, redIntensity);
\}de1 ay (DISPLAY_TIME);

(NOT WORKING? (3 things to try)

4 \ [

LED Remains Dark or
Shows Incorrect Color
With the four pins of the LED
so close together, it's
sometimes easy to misplace
one. Try double checking each
pin is where it should be.

Seeing Red
The red diode within the RGB LED
may be a bit brighter than the
other two. To make your colors
more balanced, use a higher ohm
resistor. Or adjust in code.
analogwrite(RED_LED_PIN,
redIntensity);
to

analogwrite(RED_LED_PIN,
redIntensity/3);

Looking For More?
(shameless plug)
If you're looking to do more

why not check out all the
lovely extra bits and bobs

available from
http://www.SparkFun.com

\S 2/

“\\

[MAKING IT BETTER

Using HTML-style color codes
If you're familiar with making web pages you

might prefer to specify colors using "hex triplets"
like you do when you use HTML and CSS. A hex
triplet specifies a color using a series of letters
and numbers like * #FF0000" for red or

" #800080° for purple. You can learn more about
how this works on Wikipedia
(http://ardx.org/HEXCOL) and find a list of
colors with their associated hex triplets so you
don't need to work it out yourself.

A land of diffusion
One disadvantage of using a RGB LED made up of

three separate LEDs to generate our colors is that
sometimes it's possible to see the color of the
individual lights. One way to workaround this is to find
a way to make the light more diffuse (or scattered) so
that the individual colors mix together better. The LED
supplied with your kit is diffused rather than clear to
help improve the effectiveness of the color mixing. If
the light still isn't diffuse enough you can try putting
the LED behind some paper or acrylic; or inside a ping
Download the code from: pong ball or polystyrene ball.

\ http://ardx.org/RGBMB j

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http:/ /sparkfun.com/RGB




.:Measuring Bends:.
.:Flex Sensor:.

CIRC-13

('WHAT WE'RE DOING:
In life it's important to be flexible. But what do you do

if you want to measure how flexible an object is? You
use a flex sensor. A flex sensor uses carbon on a strip
of plastic to act like a variable resistor or potentiometer
(CIRC-08) but instead of changing the resistance by turning a knob you change it
by flexing (bending) the component. We use a "voltage divider" again (CIRC-08 &
09) to detect this change in resistance. The sensor bends in one direction and the
more it bends the higher the resistance gets--it has a range from about 10K ohm
to 35K ohm. In this circuit we will use the amount of bend of the flex sensor to
Qontrol the position of a servo.

J
ﬁ HE CIRCUIT: \

CIRC-13

i 2 Pin Header Flex Sensor
i7" Breadboard Sheet b 4 /xl /"_"\\ Wire

x1

3 Pin Head _~# 10k Ohm Resistor
Mini Servo d in Header ! Brown-Black-Orange
x1 : x1 x1

/ Schematic \

+5 volts

pin 9

o flex
Mini Servo signal E sensor
(white)

analog

in 0
s oy T e

(red)
(black) resistor
(10k ohm)

gnd——

\ (ground) (-) -

The Internet
.:download:. -
breadboard layout sheet L

http://ardx.org/BBLS13S




(EODEmmammwummmmmmmm

(copy the text and paste it into an empty Arduino Sketch)

// Based on }
// File > Examples > Servo > Knob

// Controlling a servo position using a
// potentiometer (variable resistor)

// by Michal Rinott //
<http://people.interaction-

jvrea.it/m.rinott>
#include <Servo.h>

Servo myservo; // create servo object to
// control a servo

0; // analog pin used to
// connect the

// potentiometer

// variable to read the

//value from the analog pin

int potpin =
int val;

void setup()

Serial.begin(9600);
myservo.attach(9);// attaches the servo
\\‘ // servo on pin 9 to the servo object

¥oid Toop()

CIRC-13

Download the Code from (http://ardx.org/CODE13S)

analogRead(potpin);// reads the value
/ of the potentiometer
//(value between 0 and 1023)
Serial.println(val);
val = map(val, 50, 300, 0, 179);
/ scale it to use it with the servo
// (value between 0 and 180)
myservo.write(val); // sets the servo
/ according to the
// scaled value

val =

delay(15); // waits for the servo

// to get there

(NOT WORKING? (3 things to try)

4 )

Servo Not Twisting?
Even with colored wires it is
still shockingly easy to plug a
servo in backwards. This might
be the case.

[ Servo Not Moving As

Expected
The sensor is only designed

to work in one direction. Try
flexing it the other way.
(where the striped side faces

Servo Moves Once
You may need to modify the
range of values in the call to

the map() function

(details in the making it better

in on a convex curve)

section below)

S

2/

[MAKING IT BETTER
Calibrating the Range

While the servo is now moving chances are its
range isn't quite perfect. To adjust the range we
need to change the values in the map () function.

map(value, fromLow, fromHigh,
toLow, toHigh)

For full details on how it works:
http://ardx.org/MAP

To calibrate our sensor we can use the debug

window (like in CIRC-11). Open the debug

window then replace the fromLow value (default

50) with the value displayed when the sensor is

\un bent. Then replace the fromHigh (default

\

300) value with the fully bent value.

Applications
With sensors the real fun comes in using them in neat
and un-expected ways here are a few of our favorite
flex sensor applications.

One Player Rock Paper Scissors Glove

A glove that lets you play RPS against yourself.
http://ardx.org/RPS

Electronic Plant Brace
Monitor if your plant is bending towards light

and fix it.
http://ardg.org/BRACE

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http:/ /sparkfun.com/




.:Fancy Sensing:.
.:Soft Potentiometer:.

CIRC-14

('WHAT WE'RE DOING:
A "soft pot" (short for "soft potentiometer") is like a

regular potentiometer of the style seen in CIRC-08
except, it's flat, really thin, flexible and doesn't have a
knob. A potentiometer is also known as a "variable
resistor" and for a soft pot the resistance it provides is determined by where
pressure is applied. Pressure can be applied with your finger, a stylus or a hard
plastic "wiper". By pressing down on various parts of the strip, the resistance
varies from 100 to 10k Ohms allowing you to calculate the relative position on the
strip. You can use this to track movement on the softpot or discrete "button style"
Qresses. In this circuit we'll use it to control the color of an RGB LED.

J
ﬁ HE CIRCUIT: \

Parts:

5. CIRC-14 . H
LA, . 2 Pin Header 5mm RGB LED
«iz2%:"" Breadboard Sheet {ﬂ .
T x1 x4 I x1 /‘_‘-\ Wire

Orange-Orange-Brown
x3

ﬂ‘ Soft Potentiometer ] 330 Ohm Resistor

x1

/ Schematic \

Arduino
piLll_ pin 10  pin 9 +5 volts

resistorg Arduino
(3300hm) 4 - analog
pin 0

]
2
“

— i
N J

/ The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS14S

o




[CODE (no need to type everything in just click)

// CIRC-14 Example Code
// Wwill fade an RGB LED from Red-Green-Blue
// 1in relation to the soft pot value

// LED leads connected to PWM pins

const int RED_LED_PIN = 9; //Red LED Pin
const int GREEN_LED_PIN = 10; //Green LED Pin
const int BLUE_LED_PIN = 11; //Blue LED Pin

void setup() {
//no need for any code here

}

void Toop() {
int sensorvalue = analogRead(0);
//read the Soft Pot

int redvalue = constrain(

map(sensorvalue, 0, 512, 255, 0),0,255);
//calculate the red value (255-0
//over the range 0-512)

-

// Display the requested color

}

CIRC-14

Download the Code from (http://ardx.org/CODE14S)
(copy the text and paste it into an empty Arduino Sketch)

int greenvalue constrain(
map(sensorvalue, 0, 512, 0, 255),0,255)-
constrain(

map(sensorvalue, 512, 1023, 0, 255),0,255);
//calculate the green value (0-255
//over 0-512 & 255-0 over 512-1023)

int bluevalue = constrain(

map(sensorvalue, 512, 1023, 0, 255),0,255);
//calculate the blue value 0-255 over
//512-1023

analogwrite(RED_LED_PIN, redvalue);
analogwrite(GREEN_LED_PIN, greenvalue);
analogwrite(BLUE_LED_PIN, bluevalue);

J

(NOT WORKING? (3 things to try)

“\\

\

LED Remains Dark or
Shows Incorrect Color
With the four pins of the LED
so close together, it's
sometimes easy to misplace
one. Try double checking each
pin is where it should be.

4 q

Seeing Red
The red diode within the RGB LED
may be a bit brighter than the
other two. To make your colors
more balanced, use a higher ohm
resistor. Or adjust in code.

analogwrite(RED_LED_PIN,
redvalue);

analogwrite(RED_LED_PIN,
redvalue/3);

Bizarre Results
The most likely cause of this is
if you're pressing the
potentiometer in more than
one position. This is normal
and can actually be used to
create some neat results.
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[MAKING IT BETTER

HSB Color (Hue, Saturation & Brightness)
Our RGB LED displays colors using RGB color

codes. However this is often not the easiest way
of working with colors (as noted by the less than
reader friendly code above). A much more
intuitive system is HSB.
Full Details:
http://ardx.org/HSB

To convert from RGB to HSB all that is required is
some slightly complicated math. For an example
program visit:

http://ardx.org/CODE14MB
based on www.kasperkamperman.com's original

\code: http://ardx.org/KASP
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Now when you use the soft pot you'll notice a much
cleaner and fuller fade from red through to violet.
Faux Buttons
Because of the way the soft pot works it can also be
used to make custom buttons. To do this you define a
range of values corresponding to a discrete button.
Use the code snippet below and the debug window to
determine desired values.
if(analogRead(0) > minvalue &&
analogRead(0) < maxvalue){
buttonAction()
Then cover the soft pot with a drawn/printed button
pattern
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MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http:/ /sparkfun.com/
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